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ELECTRIC POWER RESEARCH INSTITUTE, INC. (“EPRI”) RESERVES ALL RIGHTS IN THE 
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REPRODUCED IN ANY FORM WHATSOEVER EXCEPT AS PROVIDED BY LICENSE, WITHOUT 
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Electric Power Software Center (EPSC) 
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Charlotte, NC 28262 
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SOFTWARE DESCRIPTION 

 
The Utility Fuel Inventory Model (UFIM), Version 5.0 is a software tool for (1) identifying 
least-cost fuel inventory strategies and (2) managing the risks of associated with fuel supply and 
requirements uncertainties. 

Description 
The Utility Fuel Inventory Model (UFIM) is the essential tool for performing fuel inventory 
analysis. Using the power of your personal computer, UFIM helps you develop money-saving 
inventory policies by taking into account your fuel delivery and market uncertainties, burn 
requirements, and operating constraints. As a result, you derive reliable solutions to many of the 
fuel market risk issues that your utility faces every day. 

UFIM is available from EPRI. In addition to the software there is a required small annual fee to 
provide for software maintenance and user technical application support.  In addition, it also 
recommended that new users arrange to to obtain UFIM methodology training. This training is 
inexpensive, performed on-site at the utility or over the web. The training is in-depth and helps to 
insure efficient and appropriate use of the planning tool. 

Benefits and Value 
The benefits of using UFIM are well documented by current users. Appropriate use of the tool 
can reduce fuel budget by as much as 3 to 5 percent per year. More import, using UFIM can 
result in risk mitigation plans that reduce exposure to disruptions associated with such things as 
extreme weather events and swings in fuel and energy markets.  

Platform Requirements 
Windows 2000, Windows XP, Windows Vista Business. 
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ABSTRACT 

The Utility Fuel Inventory Model (UFIM) is a tool intended to help power companies develop 
reasonable, low-cost fuel inventory policies. The principal goal of inventory management is to 
balance the cost of building and maintaining fuel reserves against the risk of running out of fuel. 
UFIM uses analytic techniques to provide utilities with insights about how to strike this balance.  

UFIM was originally designed for running on mainframe computers and then converted to run on 
your PC modern windows operating systems.  The PC user interface is a standard Windows 
implementation.   

Please note that in the conversion from a mainframe model the underlying algorithms and 
calculations in UFIM have not changed. 
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SOFTWARE INSTALLATION INFORMATION 

Installation of EPRI Software at Client Site 
EPRI develops software using a number of third party software products and tools that run on 
various operating systems and server platforms. Reports from the software industry suggest there 
are known security issues with some products and systems. EPRI recommends that, if you are 
using EPRI software, you review its use with your Information Technology (IT) department and 
their overall strategy to ensure that all recommended security updates and patches are installed as 
needed in your corporation.  If you have any concerns please call the EPRI Customer Assistance 
Center (CAC) at 1-800-313-3774 (or email askepri@epri.com).  

If you experience difficulties accessing the application 
If you experience difficulties accessing the application after standard installation on Windows 
2000 or Windows XP, please consult your IT department personnel to have proper access 
permissions setup for your use. If the problem cannot be resolved, please call the EPRI Customer 
Assistance Center (CAC) at 1-800-313-3774 (or email askepri@epri.com). 
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ABOUT THE DOCUMENTATION 

The purpose of this documentation is to describe the new Windows user interface incorporated in 
UFIM Version 5.0. This document also provides instructions for installing UFIM on your PC. 
This document complements, and does not replace, the standard UFIM documentation, which 
remains unchanged from Version 3.0 and earlier. 

The original UFIM documentation consisted of a single binder containing two volumes: UFIM 
Basic Concepts and UFIM User's Guide. The purpose of the UFIM Basic Concepts volume was 
to discuss the general nature of the inventory problem, to describe the features of UFIM, and to 
provide interested planners and decision makers with sample applications of the model. A 
companion volume, the UFIM User's Guide, provided detailed descriptions of the computer 
model input and output sets, both for the mainframe version of the model and the original 
personal computer counterpart.   

This update documentation replaces the information in the UFIM User's Guide.   An electronic 
version of the UFIM Basic Concepts volume is distributed with the Version 5.0 software and can 
be accessed from the help menu. 
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GETTING HELP 

 

TO REPORT PROBLEMS AND GET HELP RUNNING THE MODEL, CONTACT EPRI 
USER SUPPORT: 

The Software Support and Training Specialist 
Steve Chapel 
S.Chapel Associates  
(650) 856 2675 
schapel@s-chapel.co 

The EPRI Project Manager 
Jeremy Platt  
(650) 855-2628 
 jplatt@epri.com 

The Software Developer 
Mukund Thapa  
Stanford Business Software, Inc. 
(650) 796 4478 
mukundthapa@sbsinc.net
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1  
INTRODUCTION TO UFIM 

Introduction 
This User's Manual provides descriptions of the inputs and outputs for the UFIM Version 5 
software.  This chapter provides instructions on installing the model, how to learn to use the 
model, and brief description of how Version 4 differs from earlier versions. Chapter 2 describes 
the user interface and specifically describes the inputs and outputs. 

Installing the Model 

The accompanying CD disk contains the setup program that will install the model.  The system 
requirements for the model are: 

• Windows 2000, Windows XP, Windows Vista Business 

• 64mb of RAM, 

• 100mb of free space on a hard drive, 

• Acrobat Reader 5.0 installed on the host machine. 

The model uses Acrobat Reader to display this User Manual and the Basic Concepts Manual 
(both assessable from the Help menu). If the user does not have Reader it can be downloaded for 
free from Adobe's web site (www.adobe.com). 

To install the model insert the disk in the CD-ROM drive.  If the setup program does not start 
automatically, click START, select Run, enter D:/UFIM 5.0 Setup in the dialog box and click OK 
(if D: is not the drive identifier for the CD-ROM, enter the appropriate drive identifier). Then, 
follow the directions on the screen to complete the setup. Unless the user specifies otherwise 
during installation, the program, reports and database files are placed in the folder 
C:/ProgramFiles/EPRI/UFIM V5.0.  
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For Windows 2000 and Windows XP following the setup instructions provided by the setup 
program is all that is required. Because of new security procedures associated with Windows 
Vista, installing on Windows Vista requires one additional task:  

1. Open the folder where the program was installed  
(the default location is C:\Program Files\EPRI\UFIM V5.0\ ),  

2. Right click on the program (UFIM.exe) and select Properties. 

3. From the properties window, select the Compatibility tab and check the box to run in 
Administrator mode.  Below shows the Compatibility tab with the correct setting. 

 
Figure 1-1 
Compatibility Tab in Properties Window 

To uninstall the model click START, select Control Panel, select Add or Remove Programs from 
the list, select UFIM from the list, click the Remove button.  When ask "Are you sure you want 
to remove UFIM from your computer," click the Yes button.  When done close the Add or 
Remove Programs window and the Control Panel window. 

Note:  Administrative privileges are required to install the application. 

The database Sample.mdb is distributed with the program.  This database is automatically opened 
when the program is started.  The database includes two cases - Non-seasonal and Seasonal.  The 
Seasonal case is the basis for the screen shots used in Chapter 2.  To verify that the model is 
correctly installed and working, the user can run the Seasonal and Non-Seasonal cases and 
compare the summary outputs to the results files included on the CD.. 

Note: when the program is run it automatically opens the last database created by the user.  The 
first time the model is run the database will be Sample.mdb, the database distributed with the 
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program. If for some reason the model cannot find Sample.mdb a dialog box will be opened that 
allow the user to navigate to the location of the file and select Sample.mdb. 

In the next Chapter, UFIM User Interface, we explain the details of running the model including 
entering data and reviewing output reports. 

Learning to Use the Model 

UFIM™ is an easy model to use.  If the user is not familiar with the model we recommend the 
following five steps as an efficient way to become familiar with (1) the mechanics of running the 
model and (2) the methodology that underlies the model calculations: 

• Review Chapter 2 of this manual, UFIM User Interface, to become familiar with the user 
interface, the input data, and the outputs. 

• Study the inputs for both the Seasonal and Non-Seasonal cases supplied with the model 

• Run the Seasonal and Non-Seasonal cases and study the outputs.  

• Read Chapter 3, of the UFIM Basic Concepts volume, “Getting Started With UFIM.” The 
manual is distributed with the software and can be opened from the Help menu. 

• Work through the UFIM Tutorial describe in Chapter 3 of this manual. 

• Prepare a case based on the problem described in Chapter 3 of the User's Manual. 

• Perhaps most important arrange for new user training either by contacting the EPRI 
Project Manager, Jeremy Platt or The Software Support And Training Specialist, Steve 
Chapel 

What's New 

Version 5 reproduces the calculation capability of Version 3.1.  A modern Windows interface 
was added and the software was rewritten in C++ to take advantage of increased speed and 
improved memory management.  Context sensitive is available for all input fields.  Placing the 
cursor in any field and pressing F1 will active the help.  

In addition to the modern windows interface, Version 5 allows for increased demand distribution 
states and maximum inventory step-size was increased from 30 to 80. This last change improves 
the ability to model problems in greater granularity of detail (see the UFIM Basic Concepts 
manual for definitions and discussion of these concepts – step-size and demand states or steps.  

Error Traps 

The software traps most data inconsistencies at the user interface level. However, there are 
certain situations where error conditions are recognized only after the model is processing the 
data. In order to ensure robustness of the software, the software traps run-time generated errors 
and reports them back to the user in a Window as a RUN-TIME ERROR. When this happens the 
user is asked click OK and the model returns to the main window. 

In some (hopefully rare!) instances, the error message is one that should not have occurred and 
occurs only because of an internal inconsistency in the software. In this case, the names and 
phone numbers of contacts at EPRI and Stanford Business Software, Inc. (SBSI) will be 
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displayed. Please contact at least one of the support organizations with the exact message as it 
appears on your screen. 

In other situations, the error message will point you in the right direction and you can attempt to 
modify the data for the case and re-run the model (after restarting the software). However, in this 
case too, should the message be unclear or if you have any questions, please do not hesitate to 
contact EPRI, The Software Support and Training Specialist, Steve Chapel or SBSI. 

 Contacting Us 

TO REPORT PROBLEMS AND GET HELP RUNNING THE MODEL CONTACT EPRI 
USER SUPPORT: 

The Software Support Specialist 
Steve Chapel  
S. Chapel Associates 
(650) 856 2675 
schapel@s-chapel.com 

The EPRI Project Manager 
Jeremy Platt 
 (650) 855-2620 
 jplatt@epri.com  

The Software Developer 
Mukund Thapa 
Stanford Business Software, Inc. 
 (650) 796 4478 
mukundthapa@sbsinc.net  
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2  
USING THE UFIM USER INTERFACE 

Introduction 

This Chapter describes the UFIM user interface and the way inputs and outputs are handled by 
the interface. The user interface is a standard Windows implementation. It was written in Visual 
Basic and output reports are created as text files. Because of the Windows implementation, users 
should be able to edit data sets, run the model and view results with little or no reference to this 
User Guide. However the modeling process requires considerable thought and it is highly 
recommended that model users carefully study the methodology described in the UFIM Basic 
Concepts volume.  

Running the Model 
To run the model click START, select All Programs, and double click the  
EPRI->UFIM 5.0->Launch UFIM 5.0. The program icon is simplified power plant.  Figure 2-1 
is an enlarged picture of the icon.  The user can also open the program by double clicking the 
Launch UFIM 5.0 program icon on the DESKTOP. 

 
Figure 2-1 
UFIM Program Icon 

When the model is started, a start-up window is displayed.  This screen has the name of the 
program, the version number, and the list of individuals that developed the program.  The user 
can click the OK button to proceed or the Cancel button to exit UFIM. 

Following this, the window for Select Case is displayed as in Figure 2-2. This window gives the 
user the option to select an existing case or create a new case. Initially, if no cases are entered, 
Work on existing Case is grayed out. If cases already exist in the database, the Work on existing 
Case option is enabled.  This window is shown below. 
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Figure 2-2 
Select Case 

If the user selects Work on Existing Case, a window is opened that allows the user to select the 
case from a list.  If Create New Case is selected, a window is opened that allows the user to 
specify a new case a name and description. 

If database has one or more cases, and the Work on Existing Case option in Figure 2-2 is 
selected, a popup window shows all the cases in the database.  The user can select any of the 
cases and the model will open the corresponding case.  The case used by the program is 
displayed at the top of the main screen.  Figure 2-3 shows the window displayed to open a case. 

 
Figure 2-3 
Open Case 

After an existing case is selected or a new case created, the main window is displayed as shown 
in Figure 2-4. 
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Figure 2-4 
Main Screen 

Using the main window menu system you can perform file functions, edit cases, run cases, view 
results and open the documentation.   

The File Menu 
The file menu is used to open new and existing input data sets and to save input data sets.  The 
file menu options are described next.  The main screen with the file menu open is shown below 
in Figure 2-5. 



EPRI Proprietary Licensed Material 
 
USING THE UFIM USER INTERFACE 

 

2-4 

 
Figure 2-5 
File Menu 

New Case:  Create and name a new case and the case to the current database. 

Open Case:  Select a previously-defined case to open.  You may only select from 
among cases in the current database. 

Save Case:  Saves the opened case to the current database. 

Save Case As:  Save opened case under a different case name in the current case database. 

Delete Case:  Permanently remove an existing case from the current case database.  

Print Case: Displays the input data for the current case as a text file. Using this file 
you can print or save the file to disk. 

Database Options: This menu contains options for Creating, Opening, Copying and Deleting 
case databases. 

Exit: Leave UFIM and return to the operating system. 
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The Edit Menu  

The edit menu is used to edit case data, run specifications and advanced user parameters.   

Editing Case Data 

Figure 2-6 shows the edit menu with the Edit Case Data option selected.  This option allows you 
to view or change all of the input data of the current case. 

 
Figure 2-6 
Editing Case Data 

NOTE: An extensive context-sensitive help system provides guidance for each data input element 
(if the user puts the curser in any data element and presses F1 help is provided).   In addition all 
of the data elements are explained in detail in the original user manual, UFIM Basic Concepts, 
included with this software.  Because of these two facts the input forms activated by each of the 
edit menu items are not reproduced here.  

Basic Data: Basic Data refers to a general class of information about your 
utility and how you want to set up the model.  It includes initial 
inventory levels, financial data, and details of the fuel you burn 
(fuel heat content) and how fast you burn it (plant heat rate).  It 
also includes your choice of options (Seasonality, Period, Run 
Level, and STEP) that affect the overall structure of your 
analysis.   
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Normal-Times Fuel Costs: Supply Information - Normal Times Fuel Costs contains data 
concerning your utility's fuel supply line.  It includes fuel prices, 
supply constraints, and a description of any uncertainty in your 
fuel supply.  

Dist. On Supply Error: Supply Information – Distribution On Supply Error contains 
description of any uncertainty in your fuel supply.   

Normal-Times Demand Data:   Normal-Times Demand Data provides a description of your 
normal pattern of demand for fuel.  Since demand may be 
uncertain, demand data is entered in the form of probability 
distributions. 

Normal-Times Shortage Costs: If a power plant runs out of fuel, the utility must replace the 
forgone generation from the plant or curtail service.  The total 
shortage cost incurred is equal to the cost of replacement power, 
less the cost that would have been incurred had sufficient fuel 
been available. 

A Normal-Times Shortage Cost Curve indicates the marginal 
cost of replacement power during Normal-Times as a function of 
the amount of burn reduction (the percent of time that the plant is 
not run).  That is, for each level of burn reduction the curve 
represents the added cost of reducing plant output by another 
megawatt hour.  When calculating shortage costs, UFIM uses the 
average cost represented by this curve for the cost of replacement 
power during Normal-Times. The UFIM Basic Concepts Manual 
contains an extensive discussion of this input variable. 

 

Basic Disruption Data: Disruption Basic Data is the first of two categories of disruption 
data. It includes disruption frequencies, warnings, and burn 
reduction options.  

Disruption Data: Disruption Data is the second of two categories of data 
concerning disruptions.  It includes durations, fuel prices, 
demand for fuel, delivery constraints, and replacement power 
costs for each disruption. 

  



EPRI Proprietary Licensed Material 
 

USING THE UFIM USER INTERFACE 

2-7 

Editing Run Specifications 

Figure 2-7 shows the edit menu with the Edit Run Specifications option selected.  This menu 
item allows the user to select or change options that determine how UFIM will run the current 
case.  

 

 
Figure 2-7 
Editing Run Specifications 

Run Options: These options affect how UFIM operates.  In particular, they 
determine the submodels to be used and the name of the output 
file. 

Disrup./Target Options: These options concern the selection of disruption and target data 
for use in a UFIM run. 

Report Options: These options concern how UFIM will report output after the run. 

Select Disruptions: This item allows the user to select the disruptions to include with a 
model run. This disruptions must have been previously-defined 
using the Edit Case Data menu. 
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Advanced User Parameters 

 Through this menu item you can access a series of technical parameters that affect UFIM's 
operation.  These parameters give advanced users more control over how the UFIM model runs.  
Most users, however, will not need to change them. 

Run Case Menu  

This menu contains options for running one or more cases.  You can run the current case or run 
multiple cases.  The options in the Run Case menu are shown in Figure 2-8. 

 
Figure 2-8 
Run Case Menu Options 

Run Current Case 

If the option Run Current Case is selected the user is prompted by a dialog box, Figure 2-9 
asking if it is OK to run the case.   
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Figure 2-9 
Run Case Dialog Box 

If yes is selected the model runs and when complete a Run Log report is displayed, Figure 2-10. 

 
Figure 2-10 
Run Log Report 

Run Multiple Cases 

If the Edit menu option Run Multiple Cases is selected, one or more previously-defined cases can 
be run.  You may select any set of cases in the current case database.  The dialog box for 
selecting cases is shown by Figure 2-11. 
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Figure 2-11 
Input Form for Selecting Multiple Cases to Run 

Results Menu 

This menu contains options to select model outputs for viewing, printing, or exporting to a 
spreadsheet.  Figure 2-12 shows the menu options with the View Results option selected. 

 
Figure 2-12 
Results Menu With The View Results Option Selected 
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View Results 

If the Seasonal Case is selected a form is show where the user can select one of several output 
reports, Figure 2-13. The output options are  

• A Summary report,   

• a Normal-Times report,   

• a Disruption report,   

• a report listing the Case Inputs,   

• the Run Log, and   

• Your Own Table Selection. 

 
Figure 2-13 
View Results Options 

 Export to Spreadsheet 

 This menu option allows users to select model outputs to save in spreadsheet-readable format.  
The file will have the same name as the run from which it was created, with the extension CSV, 
Comma Separated Values. 

NOTE:  Because the CSV file will have the same name as the run (for example Seasonal) the 
user will need to rename the spreadsheet files if they wish to make multiple runs with the same 
case and export after each run. 
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Delete Results 

 This menu option allows users to delete all output files generated by a run.  This does not delete 
the case's original input data. 

Help Menu 

  The Help menu has 4 items,(shown by Figure 2-14):  

(1)  User Manual,  

(2)  UFIM Basic Concepts Manual,  

(3) UFIM Help System  

(4) About. 

 

 
Figure 2-14 
Help Menu Options 

The UFIM Help System item is worth noting.   From any screen you can press F1 to get help for 
that screen.  You can also select the help menu from the main menu bar.  Each heading in the 
menu is linked to a series of informational screens, the whole of which covers most topics 
relating to the model. 

On many of the screens, several topics are listed in bold at the bottom of the page. These are 
additional topics related to the current help topic.  To access help on these topics, move the 
cursor using TAB and press ENTER.  In this way you can reach any topic through the help 
menu, though you may have to pass through one or two other screens first.



EPRI Proprietary Licensed Material 

3-1 

3  
UFIM TUTORIAL 

Introduction 
In this chapter we will take you through a step-by-step tutorial to (1) create a UFIM case, (2), 
enter data for the case, (3) define the run specifications, (4) run the model, and (5) view the 
outputs.  

The purpose here is to get the use familiar with key input and the mechanics of entering data and 
running the model. Experience has show that this tutorial does not substitute for more formal 
training that includes both model mechanics and the underling methodology for solving fuel 
inventory problems. 

Create A UFIM Case 
Start the model and when the Select the Option For Case dialog box is presented select Create 
New Case and click Ok. 

 
This will bring up a New Case Information dialog box where you must specify the case name 
and description. You can pick any case name you would like. I suggest something like “My 
Tutorial” for a case name. 

 
This will create a new case in the existing database. That case will have a set of default input 
values. In the next section we will change the default values. 
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Entering Data for the “My Tutorial” Case 

Basic Data 
To begin entering data click the Edit Menu -> Edit Case Data and select Basic Data. 

 
Figure 3-1 
Menu – Edit Case Data 

This will open a tabbed window form where all case data is specified. The first tab is for Basic 
Data. Basic data refers to a general class of information about your utility and the power plant 
for which you are analyzing fuel inventories. It includes current inventory levels, financial data, 
and a description of the plant and fuel being analyzed. It also includes options for Seasonality 
and Time and specification of Step Size – these affect the overall structure of your analysis. 

  



EPRI Proprietary Licensed Material 
 

UFIM TUTORIAL 

3-3 

The Basic Data default values and the values for the tutorial are given in the Table 3-1 below. 
The definitions of the input variables are not included here but are available via context sensitive 
help. If the user selects any input value and presses F1 the UFIM help system will display an 
explanation of the input variable. 

Table 3-1 
Input Values for Tutorial – Basic Data 

Input Variable Default Value Tutorial Input 

Case Description This is my tutorial This is my tutorial 

Seasonality Option (Yes, No) Yes Yes 

Period Option(length of Normal and 
Disruption periods 

Month, Month Month, Month 

Plant Information 

Fuel Type and Unit Coal (Tons) Coal (Tons) 

Average Plant Heat Rate 10,000 10,500 

Heat Content of Fuel 25.00 21.00 

Tons/MWH Computed by model from Heat Rate and Heat 
Content of Fuel 

Number of Kilo Tons in a Burn Day 0.1 6.0 

Inventory Step Size in Burn Days 10 5.0 

Steps Size in Kilo Units Computed by model from kilo tons in a burn day and 
step size in a burn days 

Maximum Inventory Level (in Steps) 30 80 

Starting Month (required for model 
optimization computations) 

Jan Jan 

Starting Inventory (Steps) 10 10 

Replacement of Power (calculation 
options) 

Calculated by Fraction 
Burn Reduction 

Calculated by Fraction 
Burn Reduction 

Financial Information 

Annual Real Cost of Capital 0.05 0.05 

Tax Portion of Revenue Req’s 0.02 0.025 

Physical Holding Costs – same for all 
months? 

Yes Yes 

Holding Costs ($/Tons-Month) 0.10 0.10 

 



EPRI Proprietary Licensed Material 
 
UFIM TUTORIAL 

 

3-4 

After the entering the Basic Data Values, the Basic Data input form should match Figure 3-2 
below. Before proceeding to the next step save your inputs by pressing the Save button at the 
bottom of the form. 

 
Figure 3-2 
Basic Data Input Form 
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Normal Times Fuel Costs and Delivery Constraints 
The next step is to enter the Normal Times supply data which is entered in the two tabs Supply 
Information: Normal Times Fuel Costs and Supply Information: Distribution on Supply Error.  

Fuel costs and supply are entered using the Normal Times Fuel Costs Tab. Change the default 
values for Fuel Price from 45 and change the Maximum Delivery (Steps Month) 7. After these 
changes are made the input tab should match Figure 3-3 below. 

  

 
Figure 3-3 
Normal Times Fuel Costs – Tutorial Values 

This input tab for fuel costs and constraints requires specifying (1) whether the average cost of 
fuel is independent of the quantity ordered, (2) whether the supply data is the same for each 
month and (3) the fuel price, minimum delivery and maximum delivery. Note the entries for 
minimum and maximum delivery are in steps per month. The model converts the minimum and 
maximum values to kilo units and reports these in columns 4 and 5 in the input form. The 
context-sensitive help explain each of these items. 

Note: Maximum deliver can have a very significant effect on the least-cost fuel inventory policy. 
The UFIM user is encouraged to read about this issue in the UFIM Basic Principles manual. 

  



EPRI Proprietary Licensed Material 
 
UFIM TUTORIAL 

 

3-6 

Distribution on Supply Error 
The third input tab allows the user to specify if there is any significant variation in the delivery of 
fuel during normal times. When you open this form there is a single input: shown: 

Input Distribution on Supply Variation term? (Yes or No) 

The default value is No. Change this to Yes. This will cause the model to display additional 
information that must be entered. This is a complex form and the result is shown by Figure 3-4 
below. 

 

 
Figure 3-4 
Distribution on Supply Error – Default Values 

This form allows the user to specify uncertainty in the fuel deliveries given the amount actually 
ordered. If the uncertainly varies by month of the year the data can be entered by month. For this 
tutorial we will assume that uncertainty is the same for each month. Thus the first change is to 
check the box Check if Same for Each Month. The second change is, using the box Select Curve, 
select Distribution 2 and click the Remove button. Finally the table on the left allows you to 
specify (1) the order shortfall (steps per month) and the probability of the shortfall. The default 
shortfall values will be used in this tutorial.  

Note the meaning of the order shortfall values: there is a 5% change that there will be a shortfall 
of one step and a 5% chance of shortfall of -1 step.. The minus -1 means that there is a 5% 
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chance that you will get one step more than ordered. For this tutorial with these input values we 
are assuming that 90% of the time you exactly what is ordered, 5% of the time you get one step 
more than ordered and 5% of the time one step less than ordered. 

The input form with tutorial values is given in Figure 3-5 below. 

 

 
Figure 3-5 
Distribution on Supply Error – Tutorial Values 
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Normal Times Demand Data 
The next input tab is used for specifying normal times demand information. If you click that tab 
you will see the form shown in Figure 3-6 below. This form appears similar to the previous form. 
You must specify if the demand information is the same for each month and you must enter 
demand probability distribution information. 

 

 
Figure 3-6 
Normal Times Demand Data – Default Values 

For this tutorial we are going to assume that demand varies by month and specifically that 
December, January and February are different than the rest of the months. Thus we need two sets 
of demand information, one for Jan. – Feb. and one for the rest of the months (note you could 
have different demand information for each month). The default inputs already have two demand 
distributions defined. Also note that for each month there is a drop-down box that allows you to 
choose the distribution that applies for that month. 

The only changes that we are going to make to the default demand data is to the demand 
distributions themselves. The UFIM model requires that you specify probability distributions for 
demand. Because fuel inventories help insure against variation in demand and supply, carefully 
specifying the potential variation in demand is important. For the purpose of this tutorial, we 
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specify two distributions using five discrete points. Thus you should select first select 
Distribution 1, change the Number of Point in Curve to 5 and enter the values for distribution , 
Demand (Steps Month) and Probability, from Table 3-2. Repeat this process for distribution 2. 

 
Table 3-2 
Normal Times Demand Data for Tutorial 

Distribution 1 Distribution 2 

Demand  
(Steps Month) 

 
Probability 

Demand  
(Steps Month) 

 
Probability 

4 .05 2 .05 

6 .20 4 .20 

7 .50 5 .50 

8 .20 6 .20 

10 .05 8 .05 

 

When completed the form should match Figure 3-7 when Distribution 1 is selected and match 
Figure 3-8 when Disruption 2 is selected.  

A technical note here: A five point discrete representation will many times capture most of the 
information contained in a full probability distribution. Thus characterizing demand uncertainty 
using a discrete distribution with 5 points is usually adequate for fuel inventory modeling 
purposes. The UFIM allows the user to specify demand uncertainly using up to 10 points. 
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Figure 3-7 
Normal Times Demand Data – Tutorial Values for Distribution 1 

 
Figure 3-8 
Normal Times Demand Data – Tutorial Values for Distribution 2 
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Normal Times Shortage Cost Data 
The next step to enter normal times shortage cost information. If you click the Normal Times 
Shortage Cost Data tab you will see the form shown in Figure 3-9 below. This form appears 
similar to the demand input tab form. As before you must specify if the shortage cost information 
is the same for each month and you must enter the shortage cost curve information. 

 

 
Figure 3-9 
Normal Times Shortage Cost Data – Default Values 

For this tutorial we are going to assume that shortage costs vary by month and specifically that 
December, January and February are different than the rest of the months. Thus we need two sets 
of cost information, one for Jan. – Feb. and one for the rest of the months. The default inputs 
already have two shortage cost distributions defined. Also note that for each month there is a 
drop-down box that allows you to choose the distribution that applies for that month. 

The only changes that we are going to make to the default data is to the shortage cost 
distributions themselves. The UFIM model requires that you specify shortage cost curves by 
defining sets of points of (1) the fraction burn reduction and (2) the incremental shortage cost 
associated with that burn reduction. These pairs of points are entered in the grid on the left. The 
points are plotted on the right. 
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For the purpose of this tutorial, we specify two distributions using four discrete points. Thus you 
should select first select Distribution 1, leave the Number of Point in Curve set at 4 and enter the 
values for shortage cost curve. Replacement Power Cost ($/MWH) and Fraction Burn Reduction, 
from Table 3-3Error! Reference source not found.. Repeat this process for Distribution 2. 

 
Table 3-3 
Normal Times Shortage Cost Data for Tutorial 

Distribution 1 Distribution 2 

Replacement 
Power Cost  
($/MWH) 

Fraction 
Burn 

Reduction 

Replacement 
Power Cost  
($/MWH) 

Fraction 
Burn 

Reduction 

25 0.25 25 0.25 

50 0.40 40 0.40 

75 0.75 60 0.75 

100 1.00 75 1.00 

 

When completed the form should match Figure 3-10 when Distribution 1 is selected and match 
Figure 3-11 when Disruption 2 is selected.  

Again a technical note: There is extensive documentation of the precise meaning of the shortage 
cost curves in the UFIM Basic Concepts Manual. UFIM users are encouraged to study the 
technical documentation. 
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Figure 3-10 
Normal Times Shortage Cost Data – Tutorial Values for Distribution 1 

 
 

Figure 3-11 
Normal Times Shortage Cost Data – Tutorial Values for Distribution 2 
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Disruption Basic Data 
All of the Normal-Times data have been specified. The next step is to enter the basic data for one 
or more disruptions. For this tutorial we will be entering data for one disruption. You sould click 
the tab Disruption Types: Basic Data. The default values for this set of inputs is given in Figure 
3-12 below. 

 

 
Figure 3-12 
Disruption Types: Basic Data – Default Values 

This input form allows you to add, copy and delete disruptions. For each disruption you must 
provide eight inputs:  (1) a disruption type – just a name, (2) the average number of years 
between disruptions, (3) warning accuracy, (4) warning length, (5) maximum duration, (6) allow 
burn reduction, yes or no, (7) order allowed during warning, yes or no, and (8) order allowed 
during disruption, yes or no. 
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For this tutorial we are going to change the defaults to match the values in Figure 3-13: 

 

 
Figure 3-13 
Disruption Types: Basic Data – Tutorial Values 

Disruption Data – Probabilities 
The next step is to enter the remaining inputs required to describe disruptions. Click the 
Disruptions tab and the form ssown in Figure 3-14 below will be displayed. This form has a 
series of tabs on the right side. The first tab allows you to enter probabilities associated with each 
disruption defined in the Disruptions Types tab.  

Two sets of probabilities are required: (1) the probability that the disruption will occur in a given 
month of the year and (2) probabilities on the length of the disruption. The default values, Figure 
3-14, are a probability of 1.0 that the disruption will occur in January and no other month, and a 
probability of 1.0 that the disruption will last one month. 

We are going to change these values by assuming that the disruption can occur in December, 
January and February with probabilities 0.2, 0.5 and 0.3 respectively. We also assume that the 
probability that the disruption will last one month is 0.5 and the probability that it will last two 
months is 0.5. The form with tutorial value is shown in Figure 3-15. 
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Figure 3-14 
Disruption Probabilities – Default Values 

 
Figure 3-15 
Disruption Probabilities – Tutorial Values 
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Disruption Data – Fuel Prices 

The next disruption input is fuel prices. You should click the Fuel Prices tab and the default 
inputs will be displayed,  

 

Figure 3-16. We are going to assume that fuel prices are the same in the disruption as in normal 
times. Thus you simply need to click the button at the bottom left of the form, Copy from 
Normal, and follow the directions. The result will be a set of fuel price inputs show by Figure 
3-17. 

 

 
 

Figure 3-16 
Disruption Fuel Prices – Default Values 
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Figure 3-17 
Disruption Fuel Prices – Tutorial Values 

Disruption Data – Delivery Constraints 

The next tab on the right is labeled delivery constraints. Click this tab and the form shown by 
Figure 3-18 is displayed.  Because orders are allowed during disruptions (there is not a total 
supply disruption), Figure 3-13, you must specify the maximum delivery capability during 
disruptions. For this tutorial set the maximum delivery to 3 steps per month (less than half of the 
normal times delivery and less than of expected demand during December – February). Figure 
3-19 shows the form with the tutorial input values. 
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Figure 3-18 
Disruption Delivery Constraints – Default Values 

 
Figure 3-19 
Disruption Delivery Constraints – Tutorial Values 
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Disruption Demand Data 

The UFIM model allows for power plant burn requirements to be different during disruptions 
than during normal times. For example a cycling plant might be forced into base load operation 
during a nuclear power plant forced outage. However for the purpose of this tutorial we are 
assuming that demand will be the same during normal and disruption periods.  

You should click the Demand Data tab on the right. This will display the form in  

Figure 3-20. 

 

 
Figure 3-20 
Disruption Demand Data – Default Values 

In order to set the demand during disruptions to the same values as for normal times you should 
click the button on the bottom left, Copy from Normal. This will display the dialog box shown 
below. Select Copy all Curves and click Copy.  

 
This will copy the demand distributions Distribution 1 and Distribution 2 to the form shown by 
Figure 3-21. These distributions will be used by the model to represent burn requirements during 
the disruption. 
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Figure 3-21 
Disruption Demand Data – Tutorial Values 

Disruption Cost Curve Data 

In exactly the same manner as for demand, the UFIM model allows for power plant cost curve 
data to be different during disruptions than during normal times. For the purpose of this tutorial 
we are assuming that burn reduction costs will be the same during normal and disruption periods.  

You should click the Cost Curve Data tab on the right. This will display the form shown by 
Figure 3-22. 
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Figure 3-22 
Disruption Cost Curve Data – Default Values 

In order to set the burn reduction cost curves to the same values as for normal times you should 
click the button on the bottom left, Copy from Normal. This will display the dialog box shown 
below. Select Copy all Curves and click Copy.  

 
This will copy the demand distributions Distribution 1 and Distribution 2 to the form shown by 
Figure 3-23Figure 3-21. These distributions will be used by the model to represent shortage costs 
during the disruption. 
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Figure 3-23 
Disruption Cost Curve Data – Tutorial Values 

This completes the case data entry for the tutorial. The final step before you can run the model is 
to set the Run Specifications. 

Edit Run Specifications 
To initiate the process of setting run specifications, click Edit -> Edit Run Specifications and 
select Run Options, Figure 3-24. 

 

 
Figure 3-24 
Run Specifications Menu 

This will open a form with four tabs at the top. The first tab, Run Options, will be selected, 
Figure 3-25 
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Edit Run Options 
The Run Options form allows you to set the Run Name and the Run Level. The default value for 
Run Name is the case name – My Tutorial. UFIM is composed of three sub models: (1) 
Disruption management, (2) Policy Development and (3) Simulation. The Disruption 
Management sub model is always run. The user has the options to also run the Policy 
Development and Simulation sub models. 

The Disruption Management sub model computes costs for each disruption that the user 
specifies. The Policy Development sub model computes the least cost inventory policy. The 
simulation sub model allows the user to specify targets above and below the least cost (optimal) 
inventory policy and computes the costs associated with these policies. Figure 3-25 has the 
default Run Option values.  

 

 
Figure 3-25 
Run Options – Default Values 

Figure 3-26 has the tutorial Run Option values. Note that we are going to run all three sub 
models and leave the Run Name as My Tutorial. 

 
Figure 3-26 
Run Options – Tutorial Values 
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Disruption/Target Options 
The next tab in the Run Specifications form is Disruption/Target Options. Default values are 
shown in Figure 3-27. 

 
Figure 3-27 
Disruption/Target Options – Default Values 

We are going to leave the default values unchanged except for the target increments. Here the 
default values for each month are 10 Kilo Units. You should change these to 30. The tutorial 
inputs are shown in Figure 3-28 

 
Figure 3-28 
Disruption/Target Options – Tutorial Values 
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Report Options 
The next tab is Report Options. Default values are shown in Figure 3-27. 

 
Figure 3-29 
Report Options – Default Values 

Report Options allow you to have inventory output specified in kilo units or burn days. The 
default value is kilo units. For this tutorial outputs are reported in burn days. You also need to 
change the default value for kilo tons burned day from 3 to 6. The tutorial values are shown in 
Figure 3-30 

 
Figure 3-30 
Report Options – Tutorial Values 
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Select Disruptions 

The final Run Specification input form is Select Disruptions. This form allows you to select the 
disruptions that will be included in any given UFIM run. The default is for all disruptions to be 
selected. 

This form allows the user to very quickly make multiple UFIM runs with various combinations 
of disruptions included. For this tutorial we will make a single run that includes the one 
disruption that we have defined, Freeze. The tutorial input form for Select Disruptions is shown 
below, Figure 3-31. 

 
Figure 3-31 
Option to Select Disruptions – Tutorial Values 
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Running the Model and Viewing Results 
At this point the input values have been completely specified and the Run Specifications have 
been set. All that is left to do is run the model and view the outputs.  

Running the Model 
Running the model is straight forward. Click the Run Case menu and select Run Current Case, 
Figure 3-32 

 
Figure 3-32 
Menu for Running Cases 

His will bring up the following dialog box: 

 
Click Yes and the model will run and display the Run Log, Figure 3-33 below. The Run Log is a 
text file created by UFIM and it reports warning and errors and the status of reading inputs, 
running each sub model and reporting outputs. For this case all inputs, sub model runs and 
outputs are successful. There are a series of warning. For each month there is the possibility of a 
Supply Shortfall. This is caused by the fact that there is uncertainty in Normal Times delivery and 
specifically there is a 5 percent chance of receiving less than the amount ordered, see Figure 3-5. 



EPRI Proprietary Licensed Material 
 

UFIM TUTORIAL 

3-29 

 
Figure 3-33 
Run Log for Tutorial 

Viewing Results 
After making a run a set of outputs are generated. The user can view the outputs by clicking 
Results -> View Results and selecting MY TUTORIAL, Figure 3-34. 

 
Figure 3-34 
View Results Menu 

This will bring up a form with a series of buttons that allows the user to open the output reports, 
Summary, Normal Times, Disruption, and so on. The selection form is show in Figure 3-35. If 
you click Summary a summary report will be generated and if you scroll down to the bottom of 
the report the two tables shown in Figure 3-36 will be displayed. The first table shows the targets 
examined by the model and the second report shows the cost details associated with each target. 
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Figure 3-35 
View Results Selection Form 

 

 
Figure 3-36 
Summary Report – Targets and Expected Costs Tables 

We do not explain the reports here. The reason is the following. There is extensive 
documentation of the outputs in both the UFIM Basic Principles Manual and in the UFIM Help 
System. If you click on the Help menu and select UFIM Help System, the system will be opened 
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and you can navigate to the section titled Viewing UFIM Reports, Figure 3-37. This system 
provides detailed explanations of each of the output reports. 

 

 
Figure 3-37 
UFIM Help System 
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